
Q. where are programs and data to be used by the computer available?

1 Output

2 Processing unit

3 Input

4 Storage

Ans: 4

Q. A parallel port is most often used by a -

1 Mouse

2 Monitor

3 Printer

4 External storage device

Ans: 3

Q. Computer follows a simple principle called GIGO which means:

1 Garbage in garbage out

2 Garbage input good output

3 Good input good output

4 Greater instructions greater output

Ans: 1

Q. Arrange the following devices in ascending order of the speed: A. RAM B. Hard disk C. Cache
D. Floppy

1 ABDC

2 BDAC

3 DBAC

4 BADC

Ans: 3

Q. What is the commonly used unit for measuring the sped of data transmission?

1 Bits per second

2 Nano seconds

3 Characters per second

4 Mega Hertz

Ans: 1

Q. Which one among the following is not included in the basic functions of operating system?

1 Job Control

2 Job Scheduling

3 Memory Management

4 Data Management

Ans: 1

Q. 'Blue tooth' technology allows -

1 Landline phone to mobile phone communication

2 Signal transmission on mobile phones only

3 Wireless communication between equipments

4 Satellite television communication

Ans: 3



Q. Which of the following statements about the Crime and Criminal Tracking Network System
(CCTNS) is/are correct?
1. It will facilitate real time access of classified criminal data to the law enforcement
authorities.
2. National Crime Record Bureau is the nodal agency mandated to implement the network in
all the states.
Select the correct answer using the code given below-

1 1 only

2 2 only

3 Both 1 and 2

4 Neither 1 nor 2

Ans: 1

Q. One byte consists of

1 four bits

2 one bit

3 ten bit

4 eight bits

Ans: 4

Q. ENIAC was

1 an electronic computer

2 an engine

3 a memory device

4 an electronic calculator

Ans: 1

Q. The operating system called UNIX is typically used for -

1 Desktop computers

2 Laptop computers

3 Supercomputers

4 All of these

Ans: 4

Q. There are several primary categories of procedures. Which of the following is not a primary
category of procedures?

1 Testing

2 Backup and recovery

3 Firewall development

4 Design

Ans: 3

Q. All of the logic and mathematical calculations done by the computer happen in/on the -

1 Central processing unit

2 Mother board

3 Memory

4 Central control unit

Ans: 1

Q. The connection between your computer at home and your local ISP is called -

1 The last mile

2 The home Stretch

3 The home page

4 The backbone



Ans: 3

Q. When speaking of computer input and output, input refers to -

1 any data processing that occurs from new data input into the computer

2 data or information that has been entered into the computer

3 the transmission of data that has been input into the computer

4 Both (C) and (D) above.

Ans: 4

Q. Computer software can be defined as--

1 the computer and its associated equipment

2 the instructions that tell the computer what to do

3 computer components that act to accomplish a goal

4 an interface between the computer and the network

Ans: 2

Q. The main memory of a computer can also be called -

1 Primary storage

2 Internal memory

3 Primary memory

4 All of these

Ans: 3

Q. Which of the following is not a type of computer software which can be thought?

1 Off-the-shelf

2 Tailor-made

3 Custom-developed

4 Off-the-shelf with alterations

Ans: 4

Q. .....are attempts by individuals to obtain confidential information from you by falsifying their
identity.

1 Phishing trips

2 Computer viruses

3 Spyware scams

4 Phishing Scams

Ans: 4

Q. The main job of CPU is to -

1 carry out program instructions

2 Store data/information for future use

3 Process data and information

4 Both (A) and (C)

Ans: 4

Q. Which of the following is an example of an optical disk?

1 Magnetic disks

2 Memory disks

3 Data bus disks

4 Digital versatile disks

Ans: 4

Q. Which of the following is an example of storage devices?

1 Magnetic disks



2 Tapes

3 DVDs

4 All of these

Ans: 4

Q. A person who used his or her expertise to gain access to other people's computers to get
information illegally or do damage is a -

1 Hacker

2 Spammer

3 Analyst

4 Programmer

Ans: 1

Q. A popular way to learn about computers without ever going to a classroom is called -

1 i-learning

2 isolated learning

3 e-learning

4 close learning

Ans: 3

Q. Which of the following is a storage device that uses rigid, permanently installed magnetic
disks to store data/information -

1 Floppy diskette

2 Hard disk

3 Permanent disk

4 None of these

Ans: 2

Q. A sales clerk at a checkout counter scanning a tag on an item rather than keying it into the
system, is using -

1 Input automation

2 Item data automation

3 Scanning automation

4 Source data automation

Ans: 3

Q. Main memory works in conjunction with -

1 RAM

2 Special function cards

3 CPU

4 Intel

Ans: 3

Q. The collection of links throughout the Internet creates an interconnected network called the -

1 WWW

2 Web

3 World Wide Web

4 All of the above

Ans: 4

Q. Cache and main memory will lose their contents when the power is off. They are--

1 Dynamic

2 Faulty

3 Volatile



4 Static

Ans: 3

Q. Vendor-created program modifications are called--

1 Patches

2 Fixes

3 Holes

4 Overlaps

Ans: 2

Q. Storage media such as a CD read and write information using --

1 Magnetic strips

2 Magnetic dots

3 A laser beam of red light

4 All of these

Ans: 4

Q. To reload a Web page, press the.... button.

1 Redo

2 Reload

3 Ctrl

4 Refresh

Ans: 4

Q. The.... controls a client computer's resources.

1 Application program

2 Instruction set

3 Operating System

4 Server application

Ans: 4

Q. The process of transferring files from a computer on the Internet to your computer is called--

1 Downloading

2 Uploading

3 FTP

4 JPEG

Ans: 1

Q. Which media have the ability to have data/information stored (written) on them by users
more than once?

1 CD-R disks

2 CD-RW disks

3 Zip disks

4 Optical Disks

Ans: 2

Q. What are the four things needed to connect to the Internet?

1 Telephone line, modem, computer, and an ISP

2 Modem, computer, PDA and ISP

3 Telephone line, PDA, modem and computer

4 monitor, keyboard, mouse, modem

Ans: 1

Q. What is e-commerce?



1 Buying and selling products and services over the Internet

2 Buying and selling international goods

3 Buying and selling products and services not found in stores

4 Buying and selling products having to do with computers

Ans: 1

Q. Storage and memory differ with respect to which of the following characteristics?

1 Reliability

2 Speed

3 Price

4 All of these

Ans: 4

Q. The ---- is the term used to describe the window that is currently being used.

1 Web Window

2 Display Area

3 Active Window

4 Monitor

Ans: 3

Q. 1024 bytes equals:

1 1 KB

2 2 MB

3 1 GB

4 1TB

Ans: 1

Q. The term 'PC-XT' refers to

1 Personal Computer External Technology

2 Personal Computer Extended Technology

3 Personal Computer Embedded Technology

4 Personal Computer Expanded Technology

Ans: 2

Q. Most networks employ devices for routing services. Routers work at which of the Following
OSI Layers?

1 Transport

2 Network

3 Presentation

4 Session

Ans: 2

Q. Which of the following will help you to improve your LAN security?

1 Change your passwords frequently

2 Install a firewall program

3 Use a proxy

4 All of the above

Ans: 3

Q. Which of the following devices discriminates between multicast and unicast packets?

1 Multicast switch

2 Bicast switch

3 Bicast router



4 Mulicast Router

Ans: 4

Q. Which of the following use routes with packet filtering rules to allow or deny access based on
source address, destination address, or port number?

1 Application layer Firewall

2 Packet Filtering Firewall

3 Router enhanced firewall

4 IP enabled firewall

Ans: 2

Q. Which of the following systems run an application layer firewall using proxy software?

1 Proxy NAT

2 Proxy client

3 Client 32

4 Proxy server

Ans: 4

Q. A packet filtering firewall operates at which of the following OSI layer?

1 At the Application layer

2 At the Transport Layer

3 At the Network Layer

4 Both 2 and 3

Ans: 4

Q. Which of the following are true about firewalls?

1 Filters network traffic

2 Can be either a hardware or software device

3 Follows a set of rules

4 All the above

Ans: 4

Q. What are some of the benefits of using a firewall for your LAN?

1 Increased access to Instant Messaging

2 Stricter access control to critical resources

3 Greater security to your LAN

4 Both 2 and 3

Ans: 4

Q. Your company receives internet access through a network or a gateway server. Which of the
following devices is best suited to protect resources and subnet your LAN directly on the
network server?

1 DSL modem

2 A multi-homed firewall

3 VLAN

4 A brouter that acts both as a bridge and a router

Ans: 2

Q. Which of the following devices is specially designed to forward packets to specific ports
based on the packet's address?

1 Specialty hub

2 Switching hub

3 Port hub

4 Filtering hub



Ans: 2

Q. After booting process which file executes automatically

1 config.sys

2 command.com

3 autoexec.bat

4 io.sys

Ans: 3

Q. A System in which a transaction access and updates a file quickly enough to affect the
original decision making is called

1 Real time system

2 time sharing system

3 both of above

4 None of above

Ans: 1

Q. In time sharing system, the user carried a conversation with the central system called

1 interacting computer

2 conversation computing

3 Both of above

4 None of above

Ans: 3

Q. The principle of time sharing is

1 large numbers of users direct access to the computer for problem solving

2 large number of user for file sharing

3 both of above

4 none

Ans: 1

Q. Allocation of a resources in a time dependent fashion to several program simultaneously
called

1 multi tasking

2 multi user

3 time sharing

4 None

Ans: 3

Q. Batch processing is also known as

1 serial

2 sequential

3 off line processing

4 all of above

Ans: 4

Q. Operating System for Microcomputer system is-

1 Unix

2 Linux

3 Windows

4 all

Ans: 1

Q. Data are accumulated and processed in group called



1 Batch Processing

2 Group processing

3 Time sharing

4 None

Ans: 1

Q. Unix Operating System use _________ Multitasking

1 Preemptive

2 Cooperative

3 multiprogramming

4 None

Ans: 1

Q. Macintosh computer use_____ Multitasking

1 Preemtive

2 cooperative

3 multiprogramming

4 none

Ans: 2

Q. Preemptive and cooperative both are type of

1 Multiprogramming

2 Multitasking

3 Multi-user

4 None

Ans: 2

Q. Multiprocessing supports more then one_____ at the same time

1 Process

2 User

3 Hardware

4 None

Ans: 1

Q. Which one allow two or more users to run programs at the same time

1 Multiuser

2 Multitasking

3 Multiprocessing

4 None

Ans: 1

Q. DMA stands for ________

1 Direct Memory Access

2 Distinct Memory Access

3 Direct Module Access

4 Direct Memory Allocation

Ans: 1

Q. Which of the following is a read only memory storage device.

1 Floppy Disk

2 Hard Disk

3 CDROM

4 None of these



Ans: 3

Q. _________ is a semi conductor memory.

1 Dynamic

2 Static

3 Bubble

4 Both a & b

Ans: 4

Q. Separate Read/Write heads are required in which of these memory access schemes.

1 Random Access

2 Sequential Access

3 Direct Access

4 None of these

Ans: 4

Q. Which of the following are the best units of data on an external storage device?

1 Bits

2 Bytes

3 Hertz

4 Clock cycles

Ans: 2

Q. In a Computer_________ is capable to store single binary bit.

1 Capacitor

2 Flip Flop

3 Register

4 Inductor

Ans: 2

Q. Which of the following commands displays names of files in sorted order?

1 DIR/N

2 DIR/SO

3 DIR/AN

4 DIR/AH

Ans: 3

Q. VIRUS stands for

1 Very Important Resource Under Search

2 Virtual Information Resource Under Resize

3 Verify Interchange Result Until Source

4 Very Important Record User Searched

Ans: 2

Q. FAT stands for

1 File Accomdation Table

2 File Access Tape

3 File Allocation Table

4 File Activity Table

Ans: 3

Q. Which command can be used to recreate the disk's tracks and sectors ?

1 FDISK



2 FORMAT

3 CHKDSK

4 ATTRIB

Ans: 2

Q. What is the switch that is used to make sure that the COPY command copied files correctly

1 /A

2 /C

3 /S

4 /V

Ans: 4

Q. Which switch should be used in the DIR command to view files in all directories ?

1 /P

2 /W

3 /S

4 /L

Ans: 3

Q. Which among the following are the best tools for Fixing errors on disks?

1 FDISK

2 SCANDISK

3 CHKDSK

4 FIXDSK

Ans: 2

Q. Which type of commands in DOS needs additional files for their execution?

1 Internal Commands

2 External Commands

3 Batch Commands

4 Redirectors

Ans: 2

Q. What is the name of the batch file that is automatically run when MSDOS is booted ?

1 RUN.BAT

2 CONFIG.SYS

3 CONFIG.BAT

4 AUTORUN.BAT

Ans: 4

Q. Which file in MS-DOS contains internal commands that are loaded during Booting process?

1 IO.SYS

2 MSDOS.SYS

3 COMMAND.COM

4 CONFIG.SYS

Ans: 4

Q. Which was the last version of MS-DOS that was released separately?

1 5.0

2 6.0

3 6.11

4 6.22

Ans: 4



Q. Who was the programmer of Ms-Dos operating system

1 R Jhon

2 Bill Gates

3 Dennis Ritchi

4 none

Ans: 2

Q. The Operating System Manages

1 Memeory

2 Processes

3 Disks and I/O devices

4 All of the above

Ans: 4

Q. Page stealing

1 Is a sign of an efficient system

2 Is taking page frames from other working sets

3 Should be the tuning goal

4 Is taking larger disk spaces for pages paged out

Ans: 2

Q. Which of the following Operating Systems do you choose to implement a client Server
Network

1 MS DOS

2 Windows 7

3 Windows XP

4 Windows 2003

Ans: 4

Q. Poor response times are usually caused by

1 Process busy

2 High I/O rates

3 High paging rates

4 Any of the above

Ans: 4

Q. When a computer is first turned on or restarted, a special type of absolute loader called____
is executed

1 Compile and Go loader

2 Boot loader

3 Bootstrap loader

4 Relating loader

Ans: 3

Q. Which of the following Operatings does not implement multitaskings truly

1 Windows 98

2 Windows NT

3 Windows XP

4 MS DOS

Ans: 4

Q. _________ is the first program run on a computer when computer boots up

1 System Software



2 Operating Software

3 Systems Operations

4 None

Ans: 2

Q. _____ transforms one interface into another interface

1 Program

2 Software

3 Data

4 None

Ans: 2

Q. The primary purpose of an operating system is....

1 To make the most efficient use of the computer hardware

2 To allow people to use the computer

3 To keep systems programmers employed

4 To make computers easier to use

Ans: 1

Q. ............ runs on computer hardware and serve as platform for other software's to run on

1 Operting System

2 Application Software

3 System Software

4 All

Ans: 1

Q. Integrated circuits contained

1 10 to 20 components

2 20 to 30 components

3 25 to 25 components

4 35 to 25 components

Ans: 1

Q. How many vaccum tubes was used in first analytical engine-

1 10000

2 12000

3 90000

4 14000

Ans: 1

Q. EDVAC is

1 Electronic Detected Variable Automatic Computer

2 Electronic Discrete Variable Automatic Computer

3 Electronic Discrete Valuable Automatic Computer

4 Electronic Developed Valuable Automatic Computer

Ans: 2

Q. ENIAC was the computer of-

1 Storage program concept

2 Processing concept

3 Electronic change concept

4 All

Ans: 1



Q. IC chips was used in-

1 First generation

2 Second generation

3 Third Generation

4 Fourth generation

Ans: 3

Q. VLIC (Very Large Integration Circuit) technology was used in which generation ?

1 First generation

2 Second generation

3 Third generation

4 Fourth generation

Ans: 4

Q. Which electronic component was use in first generation?

1 Vacuum tubes

2 transistors

3 IC chips

4 all above

Ans: 1

Q. A source program is-

1 a program written in a machine language

2 a program to be translated into machine language

3 a machine language translation of a program

4 none of these

Ans: 2

Q. Assembly Language-

1 uses alphabetic codes in place of binary numbers used in machine language

2 is the easiest language to write programs

3 need not be translated into machine language

4 none of these

Ans: 1

Q. Machine Language-

1 is the language in which programs were first written

2 is the only language understood by the computer

3 Differs from one type of computer to another

4 All of these

Ans: 4

Q. Computer software includes___

1 Application programs

2 Operating system programs

3 Packaged programs

4 All of these

Ans: 4

Q. Which of the following companies is a leader in manufacture of Hard Disk Drives?

1 Samsung

2 IBM

3 Fujitsu



4 Segate

Ans: 4

Q. Floppy Disk Drives were originally designed by-

1 IBM

2 Sony

3 Panasonic

4 Samsung

Ans: 2

Q. Floppy Disk Drives were first introduced by which of the following computer manufacturers ?

1 IBM

2 Sony

3 Panasonic

4 Compaq

Ans: 1

Q. Computers built before the first Generation of computers were

1 Mechanical

2 Electro-mechanical

3 Electrical

4 None of these

Ans: 2

Q. Punched cards were first introduced by-

1 Powers

2 Pascal

3 Jacquard

4 Herman Hollerith

Ans: 4

Q. The man who built the first Mechanical Calculator was-

1 Joseph Marie Jacquard

2 John Mauchly

3 Blaise Pascal

4 Hardward Ailken

Ans: 3

Q. The Analytical Engine developed during First Generation of computers used_________ as a
memory unit

1 RAM

2 Floppies

3 Cards

4 Counter Wheels

Ans: 4

Q. The earliest calculating devices are-

1 Abacus

2 Clock

3 Difference Engine

4 None of these

Ans: 1

Q. When you purchase a product over a Mobile Phone, the transaction is called-



1 Web Commerce

2 e-Commerce

3 m-Commerce

4 Mobile purchases

Ans: 3

Q. Which of the following cables can transmit data at high speeds-

1 Coaxial Cable

2 Optic fibre Cable

3 Twistedpair Cable

4 UTP Cable

Ans: 2

Q. What is the other name for LAN Card ?

1 NIC

2 Network Connector

3 MODEM

4 Internet Card

Ans: 1

Q. Which of the following is not a logic gate ?

1 AND

2 OR

3 NOT

4 NAT

Ans: 4

Q. What is the address given to a computer connected to a network called?

1 System Address

2 SYSID

3 Process ID

4 IP Address

Ans: 4

Q. Which of the following organisations looks at standard for representation of data on the
internet ?

1 ISOC

2 W3C

3 IEEE

4 IETE

Ans: 2

Q. The basic operations performed by a computers are-

1 Arithmetic Operation

2 Logical Opertaion

3 Storage and Relative

4 All the above

Ans: 4

Q. What is the name of the software that allows us to browse through web pages called ?

1 Browser

2 Mail Client

3 FTP Client



4 Messenger

Ans: 1

Q. Who is the founder of Oracle Corporation ?

1 Bill Gates

2 Lawrence J. Ellison

3 Andrew S Grove

4 Marc Anderson

Ans: 2

Q. Programs are execuated on the basis of a priority number in a-

1 Batch Processing System

2 Multiprogramming

3 Time sharing

4 None of these

Ans: 2

Q. What is the name of the latest Server Operating System developed by Microsoft?

1 Windows NT

2 Windows 2008

3 Windows XP

4 Windows 2003

Ans: 2

Q. Time taken to move from one cylinder of a HDD to another is called

1 Transfer Rate

2 Average seek time

3 Latency

4 Roundtrip time

Ans: 2

Q. Which of the memories below is often used in a typical computer operation?

1 RAM

2 ROM

3 FDD

4 HDD

Ans: 1

Q. Usually, in MSDOS, the primary hard disk drives has the drive letter_______

1 A

2 B

3 C

4 D

Ans: 3

Q. When a key is pressed on the keyboard,which standard is used for converting the keystroke
into the corresponding bits

1 ANSI

2 ASCII

3 EBCDIC

4 ISO

Ans: 1

Q. Word length if a personal computer ia _________



1 4 bits

2 8 bits

3 16 bits

4 64 bits

Ans: 1

Q. Which number system is usually followed in a typical 32-bit computer ?

1 2

2 10

3 16

4 32

Ans: 1

Q. The memory location address are limited to---

1 00000 to 9ffff(16)

2 00001 to 9ffff(16)

3 00010 to 9ffff(16)

4 10000 to 9ffff(16)

Ans: 1

Q. Which of the following is the largest manufacture of Hard Disk Drives ?

1 IBM

2 Segate

3 Microsoft

4 3M

Ans: 2

Q. Which technology is used in Compact disks ?

1 Mechanical

2 Electrical

3 Electro Magnetic

4 Laser

Ans: 4

Q. Which of the following devices have a limitation that we can only information to it but cannot
erase it--

1 Floppy Disk

2 Hard Disk

3 Tape Drive

4 CDROM

Ans: 4

Q. EPROM can be used for ---

1 Erasing the contents of ROM

2 Reconstructing the contents of ROM

3 Erasing and reconstructing the contents of ROM

4 Duplicating ROM

Ans: 3

Q. Primary memory stores ---

1 Data alone

2 Programs alone

3 Results alone



4 All of these

Ans: 4

Q. Memory is made up of --

1 Set of wires

2 Set of circuits

3 Large number of cells

4 All of these

Ans: 4

Q. Which of the following is not a valid size of a FLOPPY DISK?

1 8"

2 5 1/4"

3 3 1/2"

4 5 1/2"

Ans: 2

Q. Which of the following is not a valid capacity of a floppy disk ?

1 360KB

2 720KB

3 1.24MB

4 1.44MB

Ans: 3

Q. Which of the following device can store large amounts of data?

1 Floppy Disk

2 Hard Disk

3 CDROM

4 Zip Disk

Ans: 2

Q. Algorithm and Flow chart help us to---

1 Know the memory Capacity

2 Identify the base of a number system

3 Direct the output to a printer

4 Specify the problem completely and clearly

Ans: 4

Q. The contents of information are stored in ---

1 Memory data register

2 Memory address register

3 Memory access register

4 Memory arithmetic register

Ans: 1

Q. MDR(Memory Data Register) holds the ---

1 Segment number

2 Address of a memory location

3 Number of transistors

4 none of these

Ans: 3

Q. Size of the primary memory of a PC ranges between ---



1 2KB to 8KB

2 64KB and 256KB

3 256KB and 640KB

4 none of these

Ans: 3

Q. Which of the following RAM times have to be refreshed often in order to retain its contents ?

1 SIMM

2 DIMM

3 SDMM

4 DSMM

Ans: 2

Q. Which of the following statements is/are true ?

1 Cache Memories are bigger than RAM

2 Cache Memories are smaller than RAM

3 ROM are faster than RAM

4 Information in ROM can be written by users

Ans: 2

Q. Which storage device is mounted on 'reels'?

1 Floppy Disk

2 Hard Disk

3 Magnetic Tapes

4 CDROM

Ans: 3

Q. How many write cycles are allowed to a EEPROM ?

1 1

2 10

3 100

4 1000

Ans: 4

Q. How many write cycles are allowed to a RAM?

1 1

2 10

3 100

4 1000

Ans: 1

Q. Which device is used as the standard pointing device in a Graphical User Environment

1 Keyboard

2 Mouse

3 Joystick

4 Track Ball

Ans: 2

Q. In a high resolution mode, the number of dots in a line will usually be ----

1 320

2 640

3 760

4 900



Ans: 2

Q. A pixel is --------

1 A computer program that draws picture

2 A picture stored in secondary memory

3 The smallest resolvable part of a picture

4 None of these

Ans: 3

Q. Direct X is a ______

1 Computer Part

2 Software that drives Graphic hardware

3 A User Interface

4 None of these

Ans: 2

Q. Which of the following is not an output device ?

1 Scanner

2 Printer

3 Flat Screen

4 Touch Screen

Ans: 1

Q. Cursor is a___________

1 Pixel

2 Thin blinking line

3 Pointing device

4 None of these

Ans: 3

Q. Which of the following is a term related with scanners?

1 Laser

2 TWAIN

3 Catridge

4 Media

Ans: 2

Q. What are the units used to count the speed of a printer?

1 CPM

2 DPI

3 PPM

4 BIT

Ans: 4

Q. SCSI is term related with ----

1 Storage

2 Network Data Transfer

3 Keystroke Rate

4 Picture resolution

Ans: 1

Q. Who among the following is a Personal Computer manufacture from Taiwan ----

1 Sony



2 IBM

3 Samsung

4 Acer

Ans: 4

Q. Nortel is a company into manufactures ---

1 Software

2 Processors

3 Cables

4 Network equipment

Ans: 4

Q. Which computer peripheral manufacturer quotes - Empowering your PC -----

1 Canon

2 Epson

3 Mercury

4 Samsung

Ans: 3

Q. What is the name of the 64-bit Microprocessor developed by AMD?

1 Opteron

2 Risc-9000

3 iMac

4 Athlon

Ans: 1

Q. Who is the founder of BSD Unix ?

1 Bill Gates

2 Dennis Ritche

3 Bill Joy

4 Linux Torvalds

Ans: 2

Q. Which company did SCO sue for using code UNIX in its Operating System ?

1 RedaHat

2 SuSE

3 IBM

4 Microsoft

Ans: 4

Q. What is the name of the series of Laptop computers manufactured by IBM called?

1 Lappad

2 Thinkpad

3 Aptiva

4 Notepad

Ans: 2

Q. The programs which are as permanent as hardware and stored in ROM is known as

1 Hardware

2 Software

3 Firmware

4 Services

Ans: 2



Q. Macromedia is a name of a company related with ----

1 Hardware

2 Software

3 Peripherals

4 Services

Ans: 2

Q. CPU speed of a personal computer is-

1 32 KIPS

2 100 KIPS

3 1 MIPS

4 None of these

Ans: 2

Q. IC are classified on the basis of____

1 Manufacturing Company

2 Type of Computer

3 Number of Transistors

4 None of These

Ans: 3

Q. The unit of KIPS is used to measure the speed of________

1 Processor

2 Disk Drive

3 Printer

4 Tape Drive

Ans: 1

Q. Programs stored in ROM are called-

1 Hardware

2 Firmware

3 Software

4 None of these

Ans: 2

Q. MTBF means

1 Mean Time Before Failure

2 Master Time Buffer Feature

3 Most Treated Buffer Time

4 Master Test Board Feature

Ans: 1

Q. MOS stands for

1 Metal Oxide Semiconductor

2 Most Often Store

3 Method Organised Stack

4 None of these

Ans: 2

Q. Which technology is used in a CDROM Drive ?

1 Mechanical

2 Electromechanical

3 Optical



4 Fibre optical

Ans: 3

Q. A compiler is_____________

1 a combination of computer hardware

2 a program which translates from one high level language to another

3 a program which translates from one high level language to a machine level

4 none of these

Ans: 3

Q. ..... is the process finding errors in software code.

1 compiling

2 Assembling

3 Interpreting

4 Debugging

Ans: 4

Q. If a memory chip is volatile, it will-

1 Explode if exposed to high temperatures

2 Lose its Contents if current is turned off

3 Be used for data storage only

4 None Of These

Ans: 2

Q. The general term 'peripheral equipment' is used for -

1 any device that is attached to a computer system

2 large scale computer systems

3 a program collection

4 other office Equipment not associated with a desktop Computer

Ans: 1

Q. ..... is a set of Keywords, s symbols, and a system of rules for constructing statements by
which humans can communicate the instructions to be executed by a computer...

1 A Computer Program

2 A Programming Language

3 An Assembler

4 Syntax

Ans: 2

Q. A ...... contains specific rules and words that express the logical steps of an algorithm.

1 Programming Language

2 Programming Structure

3 Syntax

4 Logic chart

Ans: 3

Q. Codes consisting or Bars or lines of varying widths or lengths that are computer-readable are
known as-

1 A bar code

2 An ASCII Code

3 A Magnetic Tape

4 A Light Pen

Ans: 1



Q. Which of the following is the storage area whit in the computer itself which Holds data only
Temporarily as the computer processes instructions?

1 The Hard Disk

2 Main Memory

3 The Control unit

4 Read Only Memory

Ans: 4

Q. A collection of interrelated records is called a-

1 Management Information System

2 Spread Sheet

3 Database

4 Text file

Ans: 3

Q. Every Component of your computer is either -

1 Software of CPU/RAM

2 Input Devices and Output Devices

3 Application software or System Software

4 None of these

Ans: 2

Q. Data that is copied from an application is stored in the-

1 Driver

2 Clipboard

3 Terminal

4 Prompt

Ans: 2

Q. Which of the following is not an output device?

1 Plotter

2 Printer

3 Monitor

4 Touch Screen

Ans: 4

Q. Which of the following Devices have a limitation that we can only read it but can not erase
and modify it?

1 Tape Drive

2 Hard Disk

3 Compact Disk

4 Floppy Disk

Ans: 4

Q. Which device can understand difference between Data and programs?

1 Input Device

2 Output Device

3 Memory

4 Microprocessor

Ans: 4

Q. Multiprogamming Systems......

1 Are easier to develop than single Programming systems



2 Execute each job Faster

3 Execute more jobs in the same time period

4 None of these

Ans: 3

Q. The simultaneous execution of two or more instructions is called-

1 Sequential Access

2 Reduced Instruction set computing

3 Multiprocessing

4 None of these

Ans: 3

Q. Which Device as used as the standard Pointing Device in a Graphical User Environment?

1 Keyboard

2 Mouse

3 Joystick

4 None Of These

Ans: 2

Q. ...... is a procedure that requires users to enter an identification code and
a matchingpassword.

1 Paging

2 Logging on

3 Time-Sharing

4 Multitasking

Ans: 2

Q. An example of Telecommunication device is a -

1 Keyboard

2 Mouse

3 Printer

4 Modem

Ans: 4

Q. A character of information is represented by a(n)-

1 Byte

2 Bit

3 Field

4 None of these

Ans: 1

Q. The Process of writing out computer instructions is known as-

1 Assembling

2 Compiling

3 Executing

4 coding

Ans: 1

Q. Memory Unit is one part of-

1 Control Unit

2 Central Processing Unit

3 Output Device

4 Input device



Ans: 2

Q. The Central Processing unit contains which of the following as a Component?

1 Memory Regulation Unit

2 Flow control Unit

3 Arithmetic Logic Unit

4 None 0f these

Ans: 3

Q. Data (information) is stored in computers as-

1 Files

2 Directories

3 Floppies

4 Matter

Ans: 1

Q. Which of he following menu types is also called a drop-down menu?

1 Fly-out

2 Cascadng

3 Pop-up

4 Pull-Down

Ans: 4

Q. A modem-

1 Translates along Signals from a computer into digital Signals that can travel along conventional
telephone lines

2 Translates digital Signals from a computer into analog Signals that can travel along conventional
telephone lines

3 Demodulates digital Signals from a computer.

4 None of these

Ans: 4

Q. Personal Computers can be connected together to form a -

1 Server

2 Supercomputer

3 Network

4 Enterprise

Ans: 3

Q. Which type of file is created by Word Processing Programs?

1 Database File

2 Storage File

3 Worksheet File

4 Document File

Ans: 4

Q. Ctrl,shift and alt are called...... keys.

1 Adjustment

2 Function

3 Modifier

4 None of these

Ans: 4

Q. What are .bas, .doc, and .html examples of ?



1 Extensions

2 Domains

3 Database

4 Protocols

Ans: 1

Q. What characteristics of Read Only memory ROM, makes it useful?

1 ROM information can be easily updated.

2 ROM provides very large amounts of inexpensive Data storage.

3 Data in ROM is Nonvolatile, that is , it remains there even without electrical power

4 ROM chips are easily Swapped between different brands of computers

Ans: 3

Q. To access a mainframe or supercomputer ,users often use a-

1 Terminal

2 Node

3 Desktop

4 Handheld

Ans: 1

Q. The.... of software contains list lists of commands and options.

1 Menu bar

2 Title bar

3 Formula bar

4 Tool bar

Ans: 1

Q. Numbers in table columns are usually-

1 Right-aligned

2 Left-aligned

3 justified

4 Centered

Ans: 2

Q. A ..... contains buttons and menus that provide quick access to commonly used commands.

1 Menu Bar

2 Toolbar

3 Window

4 Action Bar

Ans: 2

Q. The.... tells the computer how to use its components.

1 Utility

2 Network

3 Operating System

4 Application Program

Ans: 3

Q. What disk is used to cold boot a PC?

1 Steup disk

2 System disk

3 Diagostic disk

4 Program disk



Ans: 2

Q. The..... manual tells you how to use a software program.

1 Documentation

2 Programming

3 Technical

4 User

Ans: 1

Q. A word in a web page that, when clicked, opens another document-

1 Anchor

2 URL

3 Hyperlink

4 Reference

Ans: 3

Q. The first page of a Web site is called the.......

1 Homepage

2 Index

3 java Script

4 Book Mark

Ans: 1

Q. A CD-RW disk-

1 Has a faster access than an internal disk

2 Is a form of optical disk, so it can only be written once

3 Holds less data than a floppy disk

4 Can be erased and rewritten

Ans: 4

Q. Compiling creates a(n)-

1 Program Specification

2 Algorithm

3 Executable Program

4 Subroutine

Ans: 3

Q. Which of the following is a popular Programming Language for developing multimedia Web
pages, Websites and web-Based applications?

1 COBOL

2 JAVA

3 ASSEMBLER

4 Nine of these

Ans: 2

Q. In Excel,..... contains one or more worksheets.

1 Template

2 Workbook

3 Active cell

4 Label

Ans: 2

Q. The Method of file organisation in which data records in a file are arranged in a specified
order according to a key field is known as the-



1 Direct access method

2 Queuing method

3 Predetermined method

4 Sequential method

Ans: 4

Q. A tuple is 1 -

1 Column of a Table

2 Two dimensional Table

3 Row of a Table

4 key of a Table

Ans: 3

Q. The Software that allows users to surf the Internet is called a/an-

1 Search Engine

2 Internet Service Provider (ISP)

3 Multimedia Application

4 Browser

Ans: 1

Q. If a new device is attached to a computer,such as a printer or scanner, its....... must be
installed before the device can be used.

1 Buffer

2 Driver

3 Pager

4 Server

Ans: 2

Q. OCR stands for-

1 Optical Character Recognition

2 Optical CPU Recognition

3 Optimal Character Rendering

4 Other Character Rsrtoration

Ans: 1

Q. A vision statement is .....

1 not required for established companies

2 not required due to competition

3 not required as no one understands them

4 a long term inspiration

Ans: 4

Q. Non-product selling means .....

1 selling variety of products

2 selling only one product

3 selling seasonal products

4 selling services

Ans: 4

Q. Marketing is a function undertaken by ......

1 All DSA's

2 All front-office staff

3 Whole organization



4 All of these

Ans: 4

Q. In Excel, Charts are created using which option?

1 Chart Wizard

2 Pivot Table

3 Pie Chart

4 Bar Chart

Ans: 1

Q. You can start Microsoft Word by using ..... button.

1 New

2 Start

3 Program

4 Control Panel

Ans: 3

Q. Bank marketing is same as ......

1 Transaction marketing

2 Service marketing

3 Indoor marketing

4 All of these

Ans: 2

Q. "Conversion" in sales language means ......

1 converting a buyer into a seller

2 converting a seller into a buyer

3 converting a prospect into a client

4 All of these

Ans: 3

Q. "Referrals" means......

1 Leads provided by operation

2 Sales persons

3 Front-office staff

4 Management staff

Ans: 1

Q. Marketing of services is known as .....

1 Transaction marketing

2 Door-to-door marketing

3 Relationship marketing

4 Internal marketing

Ans: 3

Q. With a CD you can .....

1 Read

2 Write

3 Read and Write

4 Either Read or Write

Ans: 3

Q. For creating a document, you use ..... command at File Menu.



1 Open

2 Close

3 New

4 Save

Ans: 3

Q. When you save to this, your data will remain intact even when the computer is turned off .....

1 RAM

2 motherboard

3 secondary storage device

4 primary storage device

Ans: 3

Q. When you turn on the computer, the boot routine will perform this test .....

1 RAM test

2 disk drive test

3 memory test

4 power-on self-test

Ans: 2

Q. What type of device is a computer printer?

1 Input

2 Output

3 Software

4 memory

Ans: 4

Q. The simultaneous processing of two or more programs by multiple processors is .....

1 multiprogramming

2 multitasking

3 time-sharing

4 multiprocessing

Ans: 4

Q. E-mail addresses separate the user name from the ISP using the .... symbol.

1 &

2 @

3 %

4 *

Ans: 2

Q. In MICR, C stands for .....

1 Code

2 Colour

3 Computer

4 Character

Ans: 4

Q. All the deleted files go to .....

1 Recycle Bin

2 Task Bar

3 Tool Bar

4 My Computer



Ans: 1

Q. Various applications and documents are represented on the Windows desktop by .....

1 Symbols

2 Labels

3 Graphs

4 Icons

Ans: 4

Q. What is the permanent memory built into your computer called?

1 RAM

2 ROM

3 CPU

4 CD-ROM

Ans: 2

Q. The pattern of printed lines on most products are called ....

1 prices

2 OCR

3 scanners

4 barcodes

Ans: 4

Q. Which key is used in combination with another key to perform a specific task?

1 function

2 space bar

3 arrow

4 control

Ans: 4

Q. Physical components that make up your computer are known as .....

1 Operating Systems

2 Software

3 Hardware

4 Web Browsers

Ans: 3

Q. Computers use the .... number system to store data and perform calculations.

1 binary

2 octal

3 decimal

4 hexadecimal

Ans: 1

Q. To move to the beginning of a line of text, press the ... key.

1 pageup

2 a

3 home

4 enter

Ans: 3

Q. A _________ is an electronic device that processes data, converting it into information

1 Computer



2 Processor

3 Case

4 Stylus

Ans: 2

Q. _____ is processed by the computer into information

1 Number

2 Data

3 Picture

4 None of these

Ans: 2

Q. What is the default file extension for all Word documents?

1 txt

2 wrd

3 doc

4 none of these

Ans: 3

Q. Back up of the data files will help to prevent -

1 loss of confidentiality

2 duplication of data

3 virus infection

4 loss of data

Ans: 4

Q. The _________ of a system includes the programs or instructions

1 Hardware

2 Icon

3 Information

4 Software

Ans: 4

Q. What is correcting errors in a program called?

1 Debugging

2 Compiling

3 Interpreting

4 None of these

Ans: 1

Q. A compiler translates a program written in a high level language into

1 Machine Language

2 An algorithm

3 A debugged program

4 None of these

Ans: 1

Q. The primary purpose of software is to turn data into

1 Websites

2 Information

3 Programs

4 Objects

Ans: 2



Q. CPU stands for -

1 Computer Processing Unit

2 Central Processing Unit

3 Computer Protection Unit

4 None of these

Ans: 2

Q. IC chips used in computers are usually made of

1 Lead

2 Silicon

3 Chromium

4 Gold

Ans: 2

Q. One kilobyte is equal to

1 1000 bytes

2 1024 bytes

3 100 bytes

4 1023 bytes

Ans: 2

Q. Which of the following is not an example of Operating System?

1 Windows 98

2 BSD Unix

3 Microsoft Office XP

4 Red Hat Linux

Ans: 3

Q. Which supercomputer is developed by the Indian Scientists?

1 Param

2 Super 301

3 Compaq Presario

4 CRAY YMP

Ans: 1

Q. One Gigabyte is Approximately equal is

1 1000,000 bytes

2 1000,000,000 bytes

3 1000,000,000,000 bytes

4 None of these

Ans: 2

Q. Check the odd term out

1 Internet

2 Linux

3 Unix

4 Windows

Ans: 1

Q. The errors that can be pointed out by the compiler are

1 Syntax error

2 Symantic error

3 Logical error



4 Internal error

Ans: 1

Q. What is the control unit's function in the CPU

1 To transfer data to primary storage .

2 TO store program instructions.

3 To perform logic functions.

4 To decode program instructions.

Ans: 3

Q. What is the best way to have a data and the slide number appear on every slide?

1 choose Tools, Header and Footer, click Slide tab, select the desired options, click Apply to All

2 choose Insert, Header and Footer, click Slide tab, select the desired options, click Apply to All

3 choose View, Header and Footer, click Slide tab, select the desired options, click Apply to All

4 choose File, Header and Footer, click Slide tab, select the desired options, click Apply to All

Ans: 2

Q. What do you use to create a chart?

1 Pie Wizard

2 Excel Wizard

3 Data Wizard

4 Chart Wizard

Ans: 4

Q. When we opens an Internet site we see www. What is the full form of www?

1 world wide woord

2 world wide web

3 word widing works

4 words wide spiderman web

Ans: 2

Q. Which of the following commands is given to reboot the computer?

1 Ctrl + Alt + Del

2 Ctrl + Alt + Tab

3 Ctrl + Shift + Del

4 Ctrl + Alt + shift

Ans: 1

Q. Which of the following statements is true?

1 Minicomputer works faster than Microcomputer

2 Microcomputer works faster than Minicomputer

3 Speed of both the computers is the same

4 The speeds of both these computers cannot be compared with the speed of advanced computer

Ans: 1

Q. The background of any Word document -

1 is always white colour

2 is the colour you preset under the Options menu

3 is always the same for the entire document

4 can have any colour you choose

Ans: 2

Q. The blinking symbol on the computer screen is called the



1 mouse

2 logo

3 hand

4 cursor

Ans: 4

Q. Which function calculates the largest value in a set of numbers in Excel?

1 Average

2 Count

3 Minimum

4 Maximum

Ans: 4

Q. To move to the bottom of a document, press -.

1 Auto Summarize

2 Home key

3 Ctrl key + End key

4 End key

Ans: 3

Q. The Word function that corrects text as you type is referred to as -.

1 Auto Summarize

2 Auto Insert

3 Auto Correct

4 Track Changes

Ans: 3

Q. To find and load a file that has been saved -

1 select the Close command

2 select the New command

3 select the Save command

4 select the Open command

Ans: 4

Q. What displays the content of the active cell in Excel?

1 Name box

2 Row Headings

3 Formula bar

4 Taskpane

Ans: 3

Q. In Word you can force a page break -.

1 by positioning your cursor at the appropriate place and pressing the F1 key

2 by positioning your cursor at the appropriate place and pressing Ctrl + Enter

3 by using the Insert/Section Break

4 by changing the font size your document

Ans: 2

Q. Which of the following refers to a small, single-site network?

1 LAN

2 DSL

3 RAM

4 USB



Ans: 1

Q. By default, your documents print in - mode.

1 Landscape

2 Portrait

3 Page Setup

4 print View

Ans: 2

Q. How do you prevent emailed word documents from always opening in the Reading Layout?

1 From the Tools Menu > Options > General Tab > uncheck the Allow starting in Reading Layout'

2 From the View Menu > Reading Layout > General Tab > uncheck the `Allow staring in Reading
Layout'

3 From the Format Menu > Autoformat > Edit Tab > uncheck the `Use with emailed attachments'.

4 All the above

Ans: 1

Q. Which of these is a quick way to copy formatting from a selected cell to two other cells on the
same worksheet?

1 Use CTRL to select all three cells, then click the Paste Button image button on the Standard toolbar

2 Copy the selected cell, then select the other two cells, click Style on the Format menu, then click
Modify

3 Click Format Painter Button image on the Formatting toolbar twice, then click in each cell you want to
copy the formatting to

4 Use Alt to select all three cells, then click the Paste Button image button on the Standard toolbar

Ans: 3

Q. Select the odd one out -

1 Interpreter

2 Operating System

3 Compiler

4 Assembler

Ans: 2

Q. Which of the following places the common data elements in order from smallest to largest?

1 Character, file, record, field, database

2 Character, record, field, file, database

3 Character, field, record, file, database

4 Bit, byte, character, record, field, file, database

Ans: 3

Q. The Assistant is -.

1 an application that allows you to take notes and save them in a file

2 an animated character that provides help and suggestions

3 a button on the standard Toolbar that executes the Print command

4 a collection of frequently misspelled words in a dictionary file

Ans: 2

Q. Suppose you have columns of data that span more than one printed page. How can you
automatically print the column headings on each page?

1 Click Page Setup on the File menu, click the Sheet tab, and enter the row that contains these column
headings under Print titles

2 Click Page Setup on the File menu, click the Page tab, click the Options button, then enter your
choices

3 Click Page Preview on the File menu, click the Sheet tab, and enter the row that contains these



column headings under Print titles

4 Click Page Setup on the File menu, click the Sheet tab, and make a selection under the Print heading

Ans: 1

Q. How do you print your slides in a handout that includes lines for notes?

1 In the Print dialog box, select Handouts and set the number of slides per page to 3

2 In the Print dialog box, select Handouts and a number of slices per page, then select the Include
comment pages option

3 In the Print dialog box, select Notes Pages instead of Handouts

4 It cannot be done

Ans: 2

Q. Which of the following describes a relational database?

1 It provides a relationship between integers

2 It consists of separate tables or related data

3 It retrieves data related to its queries

4 It provides a relationship between floats

Ans: 2

Q. What do you press to enter the current date in a cell?

1 CTRL +; (semicolon)

2 CTRL + SHIFT + :(colon)

3 CTRL + F10

4 CTRL + F11

Ans: 1

Q. What happens when you press Ctrl + V key?

1 A Capital V letter is typed into your document at the cursor point

2 The selected item is pasted from the Clipboard

3 The selected item is pasted from the Clipboard

4 The selected drawing objects are distributed vertically on the page

Ans: 2

Q. ATM means

1 Any Time Marketing

2 Any Time Money

3 Any Time Machine

4 Automatic Teller Machine

Ans: 4

Q. CRM means -.

1 Customer Relationship Management

2 Customer Retention Manager

3 Customers' Relatives Meet

4 Channel Route Market

Ans: 1

Q. A presentation means

1 Display of products

2 Explaining the utility of products or plan

3 A gift

4 Display of Communication skils

Ans: 2



Q. The term PC means

1 Private Computer

2 Personal Computer

3 Professional Computer

4 Personal Calculator

Ans: 2

Q. Silicon Valley of India is located in

1 Dehradun

2 Bangalore

3 Hyderabad

4 Srinagar

Ans: 2

Q. A term associated with the comparison of processing speed is

1 FFTS

2 MPG

3 MIPS

4 CPS

Ans: 3

Q. An octal number 237 is equal to the binary number

1 010 011 111

2 010 111 011

3 011 101 101

4 011 000 001

Ans: 3

Q. A dot-matrix printer

1 is an input-output device

2 is an output device only

3 is an input device only

4 None of these

Ans: 2

Q. Magnetic disk a medium known as

1 Serial access

2 Direct access

3 Sequential access

4 Sequential and rotational access

Ans: 2

Q. Which of the following is true?

1 Plotters are not available for microcomputer systems

2 Micro-computer are not programmed like conventional computers

3 Mini-computers are task-oriented

4 The contents of ROM are easily changed

Ans: 3

Q. ROM is composed of

1 Magnetic cores

2 Micro-processors

3 Photoelectric cells



4 Floppy disks

Ans: 2

Q. The computer code for interchange of information between terminals is

1 ASCII

2 BCD

3 BCDIC

4 Hollerith

Ans: 1

Q. A temporary storage area, attached to the CPU, for I/O operations, is a

1 Channel

2 Buffer

3 Register

4 Core

Ans: 2

Q. A characteristic of the ASCII code is

1 its limitation to a maximum of 96 character configuration

2 its use of the zone codes 1010, 1011 and 1100

3 its independence from Hollerith code

4 All of these

Ans: 3

Q. A decimal equivalent of m second is

1 0.000001 sec

2 1000000 sec

3 0.001 sec

4 1000 sec

Ans: 1

Q. Which one of the following a file?

1 Floppy disk

2 Magnetic drum

3 magnetic tape

4 None of these

Ans: 4

Q. An I/O device which provides photographic outputs for printing galleys, is the

1 Camera printer

2 Automatic typesetter

3 Radix printer

4 All of these

Ans: 4

Q. A term used interchangeably with diskette is

1 Disk cartridge

2 Disk pack

3 Floppy disk

4 Packette disk

Ans: 3

Q. A peripheral device used in a word processing system is



1 Floppy disk

2 Magnetic card reader

3 CRT

4 All of these

Ans: 4

Q. MS-DOS is the name of a/an

1 Application software

2 Hardware

3 System software

4 None of these

Ans: 3

Q. Which of the following floppy sizes exists?

1 5.25 inches

2 4.75 inches

3 6 inches

4 8 inches

Ans: 1

Q. A characteristic of card system is

1 slowness in processing data

2 using cards as records of transactions

3 needing a larger data staff

4 All of these

Ans: 4

Q. The daily processing of corrections to customer accounts best exemplifies the processing
mode of

1 batch processing

2 real-time processing

3 time-sharing

4 off-line processing

Ans: 1

Q. Which of the following terms could be used to describe the concurrent processing of
computer programs via CRTs, on one computer system?

1 Time sharing

2 On-line processing

3 Interactive processing

4 All of these

Ans: 4

Q. The retrieval of information from the computer is defined as

1 collection of data

2 data retrieval operations

3 output

4 data output collection

Ans: 3

Q. An advantage of a distributed word processing network is

1 increased number of reports handled

2 less delay in inter-office communications



3 greater corporate control over outputs

4 All of these

Ans: 2

Q. The individual within the operations group who ordinarily uses a variety of keyboard devices,
is the

1 Data Clerk

2 Keypunch Operator

3 Data Entry Clerk

4 Computer Operator

Ans: 3

Q. Which one of the following is not a computer language?

1 BASIC

2 COBOL

3 LOTUS

4 FORTRAN

Ans: 3

Q. Which of the following packages is used for composition in printing press?

1 Lotus

2 dBase

3 Page Maker

4 Word Perfect

Ans: 3

Q. Which one of the following is not a programming language of a computer?

1 BASIC

2 FORTRAN

3 LASER

4 PASCAL

Ans: 3

Q. In computer language, one kilobyte equals

1 1000 bytes

2 1024 bytes

3 100 bytes

4 8 bytes

Ans: 2

Q. 'Foxpro' is

1 a medicine

2 a disease

3 a computer language

4 an animal

Ans: 3

Q. The brain of a computer is

1 CPU

2 CD

3 Floppy disc

4 Megabyte

Ans: 1



Q. The most widely used commercial programming computer language is

1 BASIC

2 COBOL

3 FORTRAN

4 PASCAL

Ans: 2

Q. Who was the inventor of mechanical calculator for adding numbers?

1 Charles Babbage

2 Peano

3 Newton

4 Pascal

Ans: 4

Q. Who wrote the book 'Computer Liberation and Dream Machine', the first book on personal
computers?

1 John McCarthy

2 Ted Nelson

3 Niklaus Wirth

4 Karl Capek

Ans: 2

Q. Charles Babbage invented

1 ENIAC

2 Difference engine

3 Electronic computer

4 Punched card

Ans: 2

Q. Transistors are associated with which computer system?

1 First generation

2 Fifth generation

3 Second generation

4 None of these

Ans: 3

Q. First generation computer systems used

1 Transistors

2 Vacuum tubes

3 Magnetic cores

4 Silicon chips

Ans: 2

Q. Which one of the following is a stored program machine?

1 Micro-processor

2 Calculator

3 Analog-computer

4 Micro-computer

Ans: 4

Q. Computers can be classified in which of the following hierarchical orders?

1 PC, Large, Super Micro, Super Computer

2 Super Micro, PC, Large, Super Computer



3 PC, Super Micro, Large, Super Computer

4 Large, Super Micro, Super Computer, PC

Ans: 3

Q. The unit of hardware, which an operator uses to monitor computer processing, is the

1 Card Reader

2 CPU

3 Line Printer

4 Console

Ans: 4

Q. The computer device primarily used to provide hard copy is the

1 CRT

2 Line Printer

3 Computer Console

4 Card Reader

Ans: 2

Q. Consider the following statements about Internet facility:

1 It serves as the largest one-line information system.

2 It provides the most dependable and latest mode for sending E-mail.

3 Recurring expenditure on communication E-mail is very high.

4 It is often misused and has triggered cyber-crimes.

Ans: 1

Q. Which is/are the main provisions of Information Technology (IT) Act, 2000?

1 Finalisation of contracts through electronic media.

2 Legal recognition to digital signatures and documents.

3 Making hacking with computer system an office.

4 All of the above

Ans: 4

Q. Which of the following circuit is used as a 'Memory device' in computers?

1 Rectifier

2 Flip-Flop

3 Comparator

4 Attenuator

Ans: 2

Q. The memory of a computer is commonly expressed in terms of Kilobytes or Megabytes. A byte
is made up of

1 eight decimal digits

2 eight binary digits

3 two binary digits

4 two decimal digits

Ans: 2

Q. For reproducing sound, a CD (Compact Disc) audio player uses a

1 quartz crystal

2 titanium needle

3 laser beam

4 barium titanium ceramic

Ans: 3



Q. When a CD (Compact Disc used in audio and Video system) is seen in sunlight, rainbow like
colours are seen. This can be explained on the basis of phenomenon of

1 reflection and diffraction

2 reflection and transmission

3 diffraction and transmission

4 refraction, diffraction and transmission

Ans: 4

Q. Pickup wrong definition

1 Off line - is a system peripheral equipment not controlled by CPU

2 Online - is system in which peripheral equipment is in direct contact with CPU

3 PL/I is the acronym Peripheral Listing /Index

4 Program or routine is a set sequence of instructions given to computer for problem solving

Ans: 3

Q. Terminal is a

1 device used to give supply to a computer

2 Point at which data may leave or enter the computer

3 point where wires are interconnected

4 an input/output device

Ans: 2

Q. Errors in computer results could be due to

1 encoding of data

2 transmission of data

3 manipulation of data

4 all of the above

Ans: 4

Q. Register is a

1 Set of capacitors used to register input instructions in a digital computer

2 Set of paper tapes and cards put in a file

3 Temporary storage unit within the CPU having dedicated or general purpose use

4 part of the auxiliary memory

Ans: 3

Q. WAN means -

1 Wide Area Network

2 Wine Area Network

3 Woll Area Network

4 Wide Allen Network

Ans: 1

Q. MAN is a -

1 Cost

2 Company

3 Network

4 Country

Ans: 3

Q. Which of the following is the universal gate?

1 NAND-Gate

2 OR-Gate



3 AND-Gate

4 NOT-Gate

Ans: 1

Q. The translator program that converts source code in high level language into machine code
line by line is called -

1 Assembler

2 Compiler

3 Loader

4 Interpreter

Ans: 4


